~H-drone
Processing Drone Lidar Data
with Yellowscan CloudStation

CloudStation is the software provided by Yellowscan for processing the raw lidar data from
the Surveyor Ultra 3 drone lidar unit. Processing in CloudStation is required to get LAS-
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format point cloud files.

CloudStation Setup

You will need to complete the following for setting up CloudStation

1. CloudStation Pro installed and activated on a computer (preferably one with a
decent GPU)

2. The Qinertia software directory located somewhere on your C: drive, and the path to
Qinertia executables set in CloudStation

3. The calibration file for the Yellowscan Surveyor Ultra (in the UAS Software OneDrive
folder) loaded into CloudStation

4. The measured offsets between the GNSS sensor and the center of the lidar sensor
on the Freefly Astro (in the UAS Software OneDrive folder)

5. The calibration file for the Surveyor Ultra’s built-in camera (in the UAS Software
OneDrive folder)

Data needs for processing lidar data

To process your lidar data, you will need the following:

1. (REQUIRED) The full directory from the lidar unit’s USB thumb drive that was created
for the lidar mission.
a. Lidar mission directories are named starting with “YS-“ and then an 8-digit
date code followed by a 6-digit time code. For example, “YS-20240809-
154059”
b. A new directory is created on the lidar unit’s USB storage every time a data
collection is started (quick-press of the button).
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c. The directory contains the following:

O Mame Status Date modified Type Size
EmbeddedCameraPhotos [V ) 7/29/202 e folder
D ¥S-20240725-155345 hesai [ ) 7/25/2024 9:01 AM HESAI File 3,494,118 KB
D ¥5-20240725-155345,json [V R 7/25/2024 9:01 AM JSON File 28 KB
D ¥5-20240725-1553455bg [V ) 7/25/2024 .01 AM SBG File 8281 KB
E ¥S-20240725-155345.y5 [ ) 7/25/2024 9:01 AM ys_file 6,041 KB

i. *ysfile - Yellowscan CloudStation project file
ii. *hesai-raw lidar data
iii. *.sbg-trajectory and orientation data from the IMU
iv. *json - configuration parameters for the lidar unit
v. EmbeddedCameraPhotos - directory containing the photos from the
onboard camera for point cloud colorization
2. (STRONGLY RECOMMENDED) The RINEX log file from the Emlid Reach RS3 GNSS
base station or another base station logging RINEX data at a least 1-sec intervals.

a. RINEXfiles have a 3-character extension with the first two digits being the
year and the last character “O” -e.g., *.240

b. Yellowscan recommends trimming the first few minutes off of the RINEX file
to remove inaccurate GPS readings from when the device was first turned on.
This can be done in Emlid Studio.

c. RINEXlogs can be resampled to 1-second intervals (in Emlid Studio) to
reduce file size and speed up processing in CloudStation (useful for very
large log files)

3. (RECOMMENDED) CSV file with the locations of ground control points measured
with reference to the GNSS base station

a. CSVfile should have NO header row

b. File formatis GCP_name, latitude, longitude, ellipsoidal_height

c. Note what coordinate system the coordinates are in (i.e., know the EPSG
code)

d. Perform any post-processing of the GCP locations prior to bringing them into
CloudStation.
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Important points about CloudStation

e AnyRED button in CloudStation is a “long-press” button. You must hold down the
mouse button until the button activates to confirm you really want to take that
action. There is no “undo” for these actions.

Example of a long-press button

e There generally is not an option to “undo” much of anything in CloudStation.

e Some actions will remove previous processing steps. If you change settings or open
the dialog for the SBET, it will reset the processing and you will have to run it again.

e Thereis no “Save” button. CloudStation is writing the data to the mission data
directory as you are going along.

e From what I've seen, there also is no “save as” option to save a project so you can
try something new.

e You cannot move a mission data directory once you have started processing the
data.

o Yellowscan will look for the data in the location where it was first. If it doesn’t
find it there, it will create the folder again in its original location and write
data there. Then you will have two folders with partial data in each (very
much a pain!).

o Either save the data in a permanent location before processing, or complete
the processing/export first and then move the data to its permanent location.
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Processing Lidar Data with CloudStation
1. Start CloudStation

cs

2. Click on “Create new project “

CloudStation
Pro

Create new project

3. Select the folder containing the lidar data to process.

r
Select Folder
&« v « imagery > 2024 > GuyCreekBDALidar v &} Search GuyCreekBDALidar =
Organize ~ New folder =~ [ 7]
> UAS Name B Status Date modified Type
> U-Drive emlid_logs oA 7/29/2024 7:16 PM File folder
> Uldaho GuyBDA1_020240725 [ ] 7/29/2024 7:20 PM File folder
> UIEF GuyBDA2_20240725 O A 7/28/2024 4:53 PM File folder
> VirtualFencing GuyBDA3_20240725 A 7/28/2024 4:53 PM File folder
» ZoomRecordir GuyBDA4_20240725 oA File folder
MainRockCreekBDA_20240725 SA File folder
E Desktop YS-20240620-153150 @A File folder
£ Downloads
Folder: GuyBDA1_020240725
Select Folder Cancel

CloudStation will read the data in the folder and present you with an Initialize
Project dialog box. Confirm that the sensor type is correct, “Surveyor Ultra,” change
the project name (if desired), and click Create.
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INITIALIZE A PROJECT

Select the INS files you want to add to your project

[¥] Unselect all

Surveyor Ultra

4. CloudStation will display the lidar flight path and make an initial attempt at

identifying the lidar trajectories. Trajectories will show as colored lines on the map

display and in the tool menu to the left.
. B _

FLIGHTS

PROPERTIES

PROCESS
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5. Select atrajectory by clicking on it. You can adjust the length of a trajectory by
extending the time sliders at the bottom and clicking Save.

Note, lidar trajectories should be long and straight (or nearly straight). Do no choose
the short segments of turns or extend the trajectories right up to the turns because
there can be a lot of noise in the IMU readings in these cases.
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6. Delete a trajectory by right-clicking on it in the toolbar menu and long-pressing on
Delete.

CloudStation will often pick the “ferry” paths (i.e., from the launch point to where
data collection starts/stops) as trajectories. Simply delete these.

PROJECT

Flights

FLIGHTS

~ ¥5-20240725-155345

PROPERTIES

> Selection

00:00:42

> Strip

-60° to 60°

utliers ON

PROCESS
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7. Click on any white segment of the flight line to create a new lidar trajectory. Trim the
length of the trajectory with the time slider at the bottom, then click Save.

PROJECT

Flights

FLIGHTS

¥ YS-20240725-155345

PROPERTIES

PROCESS

Once you have all the trajectories set, the next step is to bring in the base station
data and create the SBET solution for processing the data.

Note: For a quick view of the lidar data, you can skip the SBET step and click the
Process button at the bottom left. This will generate the point cloud, but the solution
will not be highly accurate and the different trajectories may not align well. However,
this is a good step in the field to ensure adequate data capture.
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8. Right-click on the project name in the tool menu to the left (above the trajectory
legend) and select Generate SBET.

Flights

FLIGHTS

v Y5-20240725-155345

9. Thefirst step in generating the SBET is to apply the lever arm offsets. These are the
distances between the GNSS antenna and the center of the lidar sensor. Lever arm
offsets are measured or calculated for each drone/lidar installation. The offsets
should not change (provided the mounting of the lidar on the drone has not
changed). Yellowscan will remember the offsets you last used or you can save
offsets for various drone/lidar setups.

Apply or confirm the lever arm offsets and click Next.

PAYLOAD CONFIGURATION

Presets
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10. The next step is to import the RINEX log file from the GNSS base station. Click the
load file button, select the RINEX file (extension of .240), and click Open.

SINGLE BASES

No rinex files

files
« v <« Reac.. > Reach-RS3_raw_20240725141547. v G SearchReach-RS3raw 202. P
Organize ~  New folder =- 1 e
> UAS O Name : Status Date modified Type
> U-Drive [] Reach-RS3_raw_20240725141547.240 O A 7/25/2024 8:15 PM 240 File
> Uldaho
> UIEF
> 7 VirtualFencing
> T ZoomRecordir
i Desktop
4 Downloads
File name: | Reach-RS3_raw_20240725141547.240 | Rinex observation files (*T02 " v
Open Cancel

11.The RINEX log file will show in the list of base stations. Click the pencilicon to edit
the base station configuration.

SINGLE BASES

Reac

=

=~ Reach-RS3_raw_202407....
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12. Confirm the base parameters (coordinates and antenna parameters). Change the

base name if this is a base station location you plan to use in the future and want to
save it. Don’t click OK yet!!

EDIT BASE

Modify current base station parameters

RRCR Barn ¢ Marker

Coordinates Reference frame Antenna parameters

.ystem 2011) (NAD8: 2011))

Antenna refer

Apply a preset

RRCR Emlid Reach RS3 EPSG:1165 43.390611929121° 1516.9668 m

You must set the correct datum for the base station for CloudStation to correctly
reference the GCPs and process the point cloud data.

Click on the pencilicon under Reference frame. The Emlid Reach base stations are

set to use the NAD83 (National Spatial Reference System 2011; EPSG:1116) datum.
Search for this and select it. Then click OK.

Select a datum

NADB83 (National Spatial Reference System 2011) (NAD83(2011)) EPSG:1116
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13. Verify that the height option is set to Ellipsoid and the project CRS is ITRF2014 (note,
this is the coordinate system used for the project. Data can be exported in any other
desired coordinate system).

14. Click Process SBET to finish the steps and generate the SBET for the project. It may
take several minutes to process the SBET.

EXPORT PARAMETERS

Height options

Geodesy
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15. Verify that the check box next to the SBET solution is checked once the SBET has
finished processing. The page icon will display a report for the SBET solution. Then
click Apply SBET to return to the main CloudStation window.

SBET PROCESSING

» |_ Y5-20240725-155345

Apply SBET

Last updated 8/9/2024
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16. Before processing the lidar data, verify the project settings. Right click on the project
name in the tool menu (above the trajectories legend) and select Settings.

FLIGHTS

¥ Y5-20240725-155345
]

2 == Settings

The main settings here relate to the maximum angle from nadir of points to include
in the point cloud (+/- 60 by default) and the minimum laser range (1.00m by
default).

Click the X to close this window when you’re finished verifying the settings. NOTE: if

you change settings after processing the lidar data, you will need to re-process the
data (i.e., it will erase the processed point cloud).

FLIGHT SETTINGS

() PPSol..  .-19

STRIPS SETTINGS 3 strips
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17. Click on the Process button to process the point cloud. This may take several
minutes.

PROCESS ‘ ° ‘

Once CloudStation finished the processing, it will display the point cloud.

Last updated 8/9/2024
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Exploring the Processed Point Cloud

Take some time to explore the point cloud and become familiar with the various tools and

how to navigate in CloudStation’s 3D map environment.

Processing steps toolbar

\Slice/profile tog S :
Point colortool

Point filtering tool

\Slice management

Major components/features of the CloudStation application interface.

CloudStation Processing Tools

=)

slic

3

g

Project Tools

Strip Adjustment
Terrain Classification
Colorize Point Cloud
Cut Overlap

Export
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Add GCPs (optional)

Ground control points can help improve the accuracy of the point cloud processing (i.e.,

with strip adjustment), or can be used as independent verification of point cloud positional
accuracy. The use of GCPs is optional.

1. Ground control points should be collected by a RTK-GNSS rover and corrected using

the same base station as used in generating the SBET. Points collected with Emlid
GNSS receivers can be post-processed (if FIX status was not available when the

points were collected) in Emlid Studio.

2. Formatthe GCP information in a CSV file with the following fields: name, longitude,
latitude, ellipsoid_height

Do not include a header row in the GCP file for CloudStation.

y A B C D E

gci-1
gcl-7
gc1-3
gcl-4
gcl-5
B 10
gcl1-6
gcl-2

-114.408
-114.408
-114.407
-114.408
-114.408
-114.408
-114.408
-114.408

43.38545
43.38483
43.38437
43.38378
43.38364
43.38411
43.38454
43.38498

1540.988
1539.484
1539.524
1538.221
1537.624
1538.424
1538.541
1540.205

3. Click on the GCP tab of the project and click the plus button to load the GCP file into

CloudStation. Note, this can be done either before or after you generate the SBET

and process the point cloud.
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PROJECT

Make sure to select the correct projection (coordinate system) for your GCPs. By
default, the Emlid GNSS receivers record in geographic decimal degrees
coordinates with the WGS84 datum (EPSG:4326). Click Load set to import the GCPs

into CloudStation.

SELECT A GCP SET
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4. IMPORTANT!! Verify that the imported GCP points line up on the point cloud surface
when looked at via a perspective view. If the points display significantly above or
below the point cloud surface, there was a problem with how the datum of the SBET
was set or in how the projection of the GCPs was specified. In this case, use of the
GCPs for strip adjustment will fail.
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Strip adjustment

Strip adjustment is a procedure for improving the alighment between different trajectories
(strips). Minor errors GNSS errors or inaccuracies in lever arm measurements can cause
the point cloud data from adjacent trajectories to not line up exactly. Strip adjustment

attempts to improve the fit between trajectories.

Elevation profile example of poorly aligned trajectories/strips prior to strip adjustment (note colors denote
different trajectory/strip).

020m »

Elevation profile example of multiple trajectories/strips after strip adjustment.

1. Choose the Strip Adjustment icon from the left-hand icon toolbar.

2. Generally, Yellowscan recommends the “Robust” method for flights involving
multiple trajectories/strips. The “Precise” method is for situations where you have
only two, long strips (e.g., along powerlines).

If you have imported GCPs, you can use these to improve the strip adjustment by
checking the box under Global Parameters.

STRIP ADJUSTMENT

Method selection

Rob

Global Parameters

] use.. Guy1GCP
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3. Click Adjust strips. This may take a while to run.

When complete, CloudStation will display a dialog box that shows the improvement
in the strip alignhment as measured from the point cloud and from the GCPs (if

used). Clicking Open report will open a PDF report of the results of the strip
adjustment.

ADJUSTING STRIPS

Misadjustment Ground Control Points misadjustment:

0081m — 0.060m 0.118m —> 0.080m
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Terrain classification (optional)

CloudStation can do a basic classification of ground vs. non-ground points in the point

cloud. You can redo the classification multiple times to try different parameters for the best
results with your scene.

1. Selectthe terrain classification button on the left-hand tool bar

2. Setthe desired parameters. Clicking on the “i” buttons next to each parameter will
provide additional information on that parameter to help in selection.

3. Click classify.

TERRAIN

Extreme
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4. Explore the ground classification in the main map window and via elevation profile
slices. Use the color tool (paint bucket icon on the left of the map/slice window) to
change the display to show the ground and non-ground classification.
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Point cloud colorization (optional)

The Yellowscan Surveyor Ultra sensor includes a RGB camera module that takes
photographs while the sensor is in operation. These photographs are used to “colorize” the
point cloud —i.e., assign RGB color values to the points. This is an optional step.

1. Chose the Colorization tool from the left-hand toolbar.

2. If photographs were captured as part of the data collection, the settings for
colorization will already be filled out.

3. Click Colorize.

NOTE: On occasion, colorization will fail with a B COLORIZATION
message that there is a discrepancy between the From Photos
number of photos and number of events (i.e.,
expected photos). The appears to happen rarely Camera Calibration
when an extra photo is captured. Navigating to the (©) Refine camera calibration
project directory, then to the
“EmbeddedCameraPhotos” folder, and deleting

Colorization method
the last photo has helped overcome this error. ol CEE

Occlusions

] Detect occlusions

Flight settings
¥ YS-20240725-155345

Use embedded camera

s
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Example of a colorized point cloud.
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Overlap removal (optional)

The areas of overlap between strips/trajectories can contain many redundant points. The
overlap removal tool identifies the highest-quality points in the overlap areas and marks
the other points to be excluded from export.

CUTOVERLAP

How does it work?

N o
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Export

The last step in CloudStation is exporting the processed point cloud and/or elevation
models. There are two export options we have with our CloudStation license — Point Cloud
and Digital Model. You can switch between the two by clicking on the icons at the top of the
dialog box. Yellowscan will suggest an appropriate output coordinate system, but that can
be changed as desired. For digital models, you can export the digital surface model (DSM),
digital terrain model (DSM, from the classified ground points), or digital height model
(difference between the DSM and STM). Clicking Export will create the export files.

#%  Point Cloud {! Digital Model

L

Settings

Settings

Entire project
Common Properties

Filters <« 0.50m

Export point classes

[«] Export colors

Select Strips

* [v] Y¥5-20240725-155345
&
] 2
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